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Where to install the server and Internet Services

You can install the FirstClass server and Internet Services on separate machines, or together on a single
computer with either a single or multiple processors. The minimum requirements for each scenario are
listed in the Release notes, but, keep in mind, the actual performance of your system will vary depending
on how powerful your hardware is and on how busy your system gets.

If you install the FirstClass server and Internet Services on two machines, consider which should go on
your most powerful machine. For example, if your system will be used primarily as a web server, you'll
want Internet Services on that machine. If your server will be under a heavy load of FirstClass users, you'll
want the server to be on the machine with the better disk system.
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While installing the FirstClass server, you will be asked whether to install FirstClass server and Internet
Services, FirstClass server only, or FirstClass Internet Services only.

If you wish to install the FirstClass server and Internet Services on the same computer, select the
FirstClass server and Internet Services option.

If you plan to install the FirstClass server and Internet Services on different machines, select the FirstClass
server only option when installing the FirstClass server. Install Internet Services separately by repeating
the installation on the other computer. Select the FirstClass Internet Services only option when prompted.

g Windows

Install the server in the root of one of your Windows drives.

Top

Installing the server on Windows

To install the FirstClass server, run the server installation program and follow the prompts.

Starting your Windows server

The FirstClass server application (fcs64.exe) resides in FCServer folder on the server machine's desktop.
You'll also see this icon on the server machine's desktop:

To start the server, double-click the icon or the file, or choose FirstClass Server from the Windows Start
menu. A console window opens. This window displays activity and error messages while the server is
running.

Top

Installing the server on Mac

Creating an fcadmin user on Mac

Before you can install a FirstClass server on Mac, you must create a user named “fcadmin” and log into the
operating system as this user. To create the fcadmin user:

1 Choose Apple menu > System Preferences > Accounts.
2 Click New User to open the New User form.
3 Type a long name and short name for the user.

The long name you choose doesn’t matter, but we recommend (and this documentation will assume)
the long name FirstClass Administrator.

The short name must be fcadmin.
Ll""; Caution
If you don't give the user exactly this short name, you won’t be able to install FirstClass.
4 Type a password for the user.
You will be asked for this password to install FirstClass and to perform other administrative duties.
6 Select “"Allow user to administer this computer”.

i‘"s Caution
If you don’t do this you won’t have administrative level permissions and won’t be able to install

FirstClass.

7 Log out of the current user account and log back in as fcadmin.
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Installing the Mac server

The installer will attempt to determine appropriate default settings for the System Profile and Internet
configuration forms to allow the FirstClass server and Internet Services to “just work”. The installer will ask
you to confirm these defaults during the installation. After installation, you should review these forms and
verify that they do not need to be changed.

The installer will also ask you whether you want the server and Internet Services to autostart on a machine
restart. By default, these programs will be running in the background after a reboot even if no user is
logged into Mac yet.

ﬂ Note

You can also disable the server or Internet Services "autostarts" manually after installation by
removing the FirstClass Server and/or FirstClass Internet Services folders from Startupltems in the
/Library folder.

To install the server:
1 Double-click “Install FirstClass Server.command” to start the installer script.
2 Follow the prompts.

In many cases, you need only press Enter to confirm the default responses.

3 Restart the Mac machine at the end of the installation process, if you chose to autostart either the
server, or Internet Services, or manually start the server and Internet Services from the Desktop icons
created by the installer.

¥ Note

If existing HTTP or FTP services are enabled on the Internet Services machine, Internet Services
will fail to open the reserved IP ports. To disable the conflicting services, choose Apple menu >
System Preferences > Sharing and clear these services.

Starting your Mac server

The FirstClass server application resides in the /Library/FirstClass Server folder and is called fcsd. It runs
as a full-fledged UNIX daemon (service), while Internet Services (fcisd) executes in the background as an
application.

You can start fcsd directly, but we suggest you use the FirstClass Server Start alias on the Mac desktop.
There are aliases on the desktop for all of the following:

N
FirstClass Server Start i‘.

FirstClass Server Stop fa

P
Internet Services Start !LEI

Internet Services Stop %E‘*

e

Status of FirstClass Services %

You can also start, stop and check the execution status of the server and Internet Services manually with
the shell scripts (provided) as follows:

1 Choose Go > Applications.
2 Double-click the Terminal application in the Utilities folder.

3 Type one of the commands below and press Enter.
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If you are prompted for a password, type the fcadmin user's password.
Possible commands:

e usr/local/fcsctl start - starts the server

e usr/local/fcsctl stop - stops the server

e usr/local/fcsctl status - checks server status

e usr/local/fcisctl start - starts Internet Services

e usr/local/fcisctl stop - stops Internet Services

e usr/local/fcisctl status - checks Internet Services status.

F] Note

Only the root user or machine administrators can start or stop the server or Internet Services. No
matter who launches these programs, they will start up under the root user and admin group and will
then fall back to the real context of the user who launched them, switching back to root-equivalent
access only while opening reserved IP ports. Currently, only one user, fcadmin, is supported, so
manually start the server and Internet Services only from this account.

Top

Installing the server on Linux

Creating an fcadmin user on Linux

Before you can install FirstClass you must create a user on your Linux system named “fcadmin” and log
into the operating system as this user. The procedure varies depending on Linux distribution, but to do this
on RedHat 9.0:

1 Login as root.
2 Open System settings > Users and Groups.
3 Click Add User to open the New User form.
4 Enter fcadmin as the User Name.
.!il"l,Caution
If you don't give the user exactly this username, you won’t be able to install FirstClass.
5 Enter a Full Name for the user.

The full name you choose doesn’t matter, but we recommend (and this documentation will assume) the
long name FirstClass Administrator.

6 Enter a password for the fcadmin account.
7 Click Ok.
8 Double-click the fcadmin user in the users list.
9 On the Groups tab select "adm".
ﬂ Note
Depending on the Linux distribution, the "adm" group may not already exist. If the group is not
present in the list, add it and then make "fcadmin" a member of this group.
&Caution
If you don’t do this fcadmin won’t have administrative level permissions and you won't be able to
install FirstClass.
10 Click Ok.
11 log out.

Installing the Linux server

The installer will attempt to determine appropriate default settings for the System Profile and Internet
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configuration forms to allow the FirstClass server and Internet Services to work without further
configuration. During the installation you will be asked to confirm these defaults. After installation, you
should review these forms and verify that all configurations are correct. This process is essential and will
not take much time.

Install FirstClass as follows:

1 Log in as fcadmin.

Download the installation file.

Open a Terminal window (Applications > System Tools > Terminal).

Navigate to the location to which you downloaded the installer file.

aua o W N

Enter: tar xzf filename

55' Note

The filename must include its extension(s).
This will produce an installer script and a folder named “files”.
Type su to access the root account.
Enter the root password when prompted for a password.

Type ./installer to run the installer.

) Note

The ./ is required.
9 Respond to the prompts.
In many cases, you need only press Enter to confirm the default responses.

10 Press Ctrl-d or type exit to exit from the root shell and return to fcadmin when the installation is
complete.

11 If you have not logged out since adding the "adm" group to the fcadmin account, you must log out and
log back in as fcadmin before starting the FirstClass server.

Starting your Linux server

The FirstClass server application resides in /opt/fcsd. It is called fcsd. It runs as a full-fledged UNIX
daemon (service), while Internet Services (fcisd) executes in the background as an application.

You can start fcsd directly, but we recommend you use the FirstClass Server Start alias on the Linux
desktop. There are aliases on the desktop for all of the following commands:

e FirstClass Server Start
o FirstClass Server Stop
¢ Internet Services Start
e Internet Services Stop
e Status of FirstClass Services.

You can also start, stop and check the execution status of the server and Internet Services manually with
the provided shell scripts as follows:

1 Open a Terminal window (Applications > System Tools > Terminal).

2 Enter one of the commands below with the syntax /usr/local/fcsctl command.
If prompted for a password, enter the fcadmin user’s password.

Possible commands:

fesctl

e /usr/local/fcsctl start
starts the server

e /usr/local/fcsctl stop
polite shutdown of the server (shutdown after all users have logged off)
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/usr/local/fcsctl force
fast shutdown of the server

/usr/local/fcsctl status
checks server status (running/not running)

/usr/local/fcsctl pause
pauses all mirrors

/usr/local/fcsctl continue
continues all mirrors

Jusr/local/fcsctl help
lists possible fcsctl commands

fcisctl

/usr/local/fcisctl start
starts Internet Services

Jusr/local/fcisctl stop
polite shutdown of IS (shutdown after all connections have logged off)

/usr/local/fcsctl force
stops IS immediately

/usr/local/fcisctl status
checks Internet Services status (running/not running).

Jusr/local/fcisctl help
lists possible fcisctl commands

*F] Note

Only the root user or machine administrators can start or stop the server or Internet Services. No
matter who launches these programs, they will start up under the root user and admin group and will
then fall back to the real context of the user who launched them, switching back to root-equivalent
access only while opening reserved IP ports. Currently, only one user, fcadmin, is supported, so
manually start the server and Internet Services only from that account.

Top

Installing and starting the FirstClass client

Because you use the FirstClass desktop client to administer FirstClass, you'll need to install this client next.
You can install it on the server machine and on any other machines from which you'd like to access the
server.

ﬂ Note

Clients are available for Windows and Mac. If you install a Linux server, you can't install a client on the
same machine.

To install the client, run the client installation program and follow the prompts.

To start the client, double-click its icon on the machine's desktop.

At the Login screen, configure your connection to the server:

1
2

3
4

Click Setup.

Choose the type of connection you want to use at "Connect via" (LocalNetwork.FCP for local
connections).

Type your server address or domain name at "Server".
Click Save.

This connection information is now saved in your default settings file, home.fc. Each connection type is
associated with a named settings file. After you've connected to the server using the client, you'll be able
to read more about client connections and settings files in Client Help in our online help.

You are now ready to log in as administrator.
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Top

Logging in as administrator

&Caution

If you are using FirstClass client software from an earlier release than your FirstClass server, upgrade
your client software. To properly administrate your system, your client software must be from the
same release as your server.

When you install the FirstClass server, a special user account is created for the administrator:
e the user ID is admin

e the password is admin

e the name is Administrator.

i"l. Caution
To preserve the security of your system, change the password for the administrator account as soon

as you log in by choosing Collaborate > Change Password. Keep the new password confidential. We
recommend that you not save the password in your settings file.

If you forget the administrator's password, you can reset it:
1 Create a text file named ResetPW.ba on your server's computer.
2 Type this in the body of the text file:
PUT USER ADMIN 1217 0 newpw
where newpw is your new password.
3 Copy or move the file to the \FCNS\Server\Batch folder.
4 Shut down your server.
5 Restart your server.

The command will be executed when the server starts up and you will be able to log in as the administrator
using the new password.

o Warning
You can change the name, password, and user ID associated with the administrator account, but never
delete this account. If you do, you won't be able to log in as the administrator, and you will have to
reinstall your server.

While you can log into the administrator account using a web-based client, you must use the FirstClass
desktop client to perform all administrative tasks.

To avoid data loss, we recommend that you create a personal user account for yourself, for day-to-day,
personal use. Just use the administrator's account to perform administrative tasks.

Top

Registering your server

When you log in as administrator for the first time, the online registration form will open automatically. If
you need to open it again for any reason, click the following icon on the administrator Desktop:

£
'l;_-i'

You must complete and send this form to OpenText to get access to online software and documentation
updates and to be allowed to post support questions to our customer conferences. You can either email the
completed preaddressed form (after you have configured FirstClass to send Internet mail) or print the form
and mail it to one of the addresses indicated in the message body.

You don't have to complete all the fields on the form and some will already be filled in for you. The help
text on the form explains which fields are optional. A copy of this form will be left on your Desktop for your



Seite 8 von 27

future reference.

Once FirstClass receives your registration, you will be sent information on accessing our own FirstClass
system (FCOL) and given access to customer conferences.

Top

Licensing your server

Your FirstClass server requires licenses to operate properly. These licenses tell FirstClass that you have a
registered FirstClass server, and indicate what features you've purchased and how many people can
connect to your system.

You can add licenses to any registered FirstClass server. Licenses can only be added to one server; you
can't have the same license on two different servers at the same time, as license files are linked to a
specific server serial number.

You can view your license information on the Licensing tab of the System Profile form.

ﬂ Note

Gateways and services don't require licenses for their connections.

Types of licenses
There are two kinds of license files, .KEY files and .LIC files.

A .KEY license is a server license, and is the first license you add to your system. All other licenses are .LIC
files and can be added in any order once the .KEY license has been applied.

FirstClass supports the following license types:

License type Description

Time-limited server Some sites have a time-limited server license. This license requires regular

license renewal. It controls the period of time in which the server will operate, not the
basic capacity limit or the features available. If you have a time-limited server,
your server will notify you of the upcoming expiry and of the options available for
purchasing a license renewal. You will receive these notices in sufficient time to
renew your license before expiry.

Regular license Specifies the number of unique regular users who can log into your system at the
same time.

11,'_3 Note

License limits apply to unique users only. This means that if you are logged
into your FirstClass account from multiple sources, you are still only using one
license. For example, if you are logged in through the FirstClass client, you
have a web browser open where you are participating in a community, and
you are using an iPhone client, you are still only using one license because all
of your connections go to the same account.

Remote license Specifies the number of unique remote users who can log into your system at the
same time.
MP Option license An MP Option license is necessary if you require more than 500 unique regular

users. Make sure that you have sufficient memory for the additional users you will
be configuring. Assuming you have already configured 500 users, make sure your
machine meets system requirements for more than 500 users before adding the
MP Option license.

After upgrading your license, you will be able to configure up to 2500 unique
users and you will be able to create more than 300 groups.

VLS license A VLS license is necessary if you require more than 2500 unique regular users.
Make sure that you have sufficient memory for the additional users you will be
configuring. Assuming you have already configured 2500 users, make sure your
machine meets system requirements for more than 2500 users before adding the
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VLS license.

After upgrading your license, you will be able to configure more than 2500 unique
users and you will be able to create more than 300 groups.

i1,'_-l_|| Note

While running the VLS license, you cannot use the mirroring feature.

LS license An LS license enables 100 users on Archive Services to allow logins by users for
self-serve restore.

To free up the license, the account must be permanently removed from the
Library Server's store; this means the user must be deleted from the main store,
and then the LS store.

Unified The FirstClass Unified Communications license permits your FirstClass server to

Communications run Voice Services.

license

Unified The Unified Communications user license works in conjunction with the Unified

Communications user Communications license. It gives your users the ability to receive email, voice and

license fax messages in one central location, the FirstClass Mailbox. Additionally, they can
access their voice, fax, and text messages using the telephone.

Text-to-speech Text-to-speech engine licenses are required for Voice Services. For more

engine license information, see the Voice Services section of the online help.

Adding licenses

Most times, you will receive a license through the FC Update Service container. Although we recommend
applying licenses through the FirstClass Update Service, a .KEY license can also be added through the
System Profile (Licensing tab) and any license can be applied using FirstClass scripting.

To apply licenses:

1 Open the FC Update Service container on the administrator's Desktop.
2 Select the document corresponding to the desired upgrade.

3 Click Apply Update.
4

Confirm that the upgrade was successful.

Removing all licenses

o Warning
Before attempting this procedure, make sure you have all of your license files available, as you will
need them to relicense your network store.

To remove all licenses:

1 Open the System Profile.

2 Select the Licensing tab.

3 Select "Remove all license files".

4 Restart the server.

Top

Reviewing the initial system configuration

Once you have installed your server and logged in as admin, review the initial system configuration as
shown on these forms:

System Profile The values on this form provide basic defaults for your system. Adjust them as
needed for your organization. For example, set the time zone to correspond to
the server's operating system time zone.
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Many of the fields on this form will be already populated with information you
filled out during the install process.

To access this form, choose Admin > System Profile.

Basic Internet Setup Select the Internet protocols used on your system.
To access this form, open the Internet Services folder on the administrator
Desktop.

Internet Gateway Most administrators won't need to configure this form. You'll only need to work

with this form if your site will use gateways.
To access this form, open the Gateways folder on the administrator Desktop.
Top

Connecting Internet Services to the server

Included with the installed FirstClass files is inetsvcs.fc. This is a settings file that FirstClass uses to enable
Internet Services to connect to the server.

If Internet Services is installed on the same machine as the FirstClass server, you can connect with either
the local machine IP address of 127.0.0.1 (default), or with the specific domain name or IP address for
that machine. However, you will still need to follow the configuration instructions below.

If Internet Services is installed on a different machine than the FirstClass server, you must enter the
domain name or IP address of your server machine. This tells Internet Services where the FirstClass server
is, enabling communication between the machines.

Configure the inetsvcs.fc file as follows:
1 Open the FirstClass client Login form.
2 Click Browse and browse to inetsvcs.fc.
The location of this file for each platform is documented later in this help.
3 Click Open to bring that information into the Login form.

Click Setup and configure the file to connect to the FirstClass server.

55' Note

The password used must match the gateway password.

Top

Configuring connections

The Netinfo file in the FirstClass network store allows you to configure TCP/IP connections. You can use
NotePad, TextEdit, or any plain text editor to view and edit this file.

The Netinfo file can contain the following parameters. Parameters must be in upper case with spaces
before and after the equal signs.

TCPGUIPORT Sets the port number of the main port that accepts connections from users of the
FirstClass client software for Mac and Windows who are connecting with TCP/IP.

Syntax
TCPGUIPORT = n

where n is the port number

Default
TCPGUIPORT = 510

This is the standard FCP port, and is the recommended value. If you don't specify a
TCPGUIPORT, 510 is used.

:\3 Notes

Connections through this port do not use the error correction component of the
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TCPGUIPORT2

TCPCLUIPORT

FirstClass protocol (FCP), because the TCP/IP protocol handles error correction.
The TCPGUIPORT accepts connections over network and remote sessions.

The number of network sessions the port can support is determined by the
number of network sessions you configure on your server.

The number of remote sessions the port can support is determined by the
number of surplus remote sessions in the server. The server comes with two
remote sessions. You can purchase additional remote sessions.

Users of terminal emulators can connect to this port by pressing Enter/Return
twice.

Users who autoregister on any port other than the TCPGUIPORT, TCPRGUIPORT,
or UDPPORT are defined as regular users.

Creates an optional, additional port for users of the FirstClass client software for Mac
and Windows who are connecting with TCP/IP.

Syntax
TCPGUIPORT2 = n

where n is the port number

Example
TCPGUIPORT2 = 3000

This is the recommended value. There is no default value.

E‘ Notes

Connections through this port do not use the error correction component of the
FirstClass protocol (FCP), because the TCP/IP protocol handles error correction.

This port accepts connections over network and remote sessions.

The number of network sessions the port can support is determined by the
number of network sessions you configure on your server.

The number of remote sessions the port can support is determined by the
number of surplus remote sessions in the server. The server comes with two
remote sessions. You can purchase additional remote sessions.

Users of terminal emulators can connect to this port by pressing Enter/Return
twice.

Users who autoregister on any port other than the TCPGUIPORT, TCPRGUIPORT,
or UDPPORT are defined as regular users.

Sets the port number of the TCP/IP port that accepts connections from users
connecting to the server with a terminal emulator or telnet client.

Syntax
TCPCLUIPORT = n

where n is the port number

Default
TCPCLUIPORT = 23

This is the recommended value. If you don't specify a TCPCLUIPORT, 23 is used.

ﬂ Notes

This port does not accept connections from the FirstClass client software for Mac
or Windows.

Connections to this port are immediate. Users do not need to start their sessions
by pressing Enter/Return twice.

This port supports the telnet protocol and telnet negotiation.

This TCPCLUI port handles line terminators differently from the standard CLUI.
Normally, only a CR is accepted as a line terminator in the CLUI. The TCPCLUI
port, however, also accepts CRLF and CRLFNULL as acceptable line terminators.
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TCPRGUIPORT

TCPFCPPORT

UDPPORT

If you are using a terminal scripting program, ensure it pauses at least 10
milliseconds (ms) after sending a line terminator.

If you are supporting older systems or clients (prior to 5.5), use port number
3003.

Creates an optional, remote TCPGUI port.

Syntax
TCPRGUIPORT = n

where n is the port number

Example
TCPRGUIPORT = 3004

This is the recommended value.

55' Notes

This port accepts native TCP/IP GUI connections, but command-line users can
connect by pressing Enter/Return twice.

Users who autoregister on any port other than the TCPGUIPORT, TCPRGUIPORT,
or UDPPORT are defined as regular users.

Creates an optional port for use with a terminal server.

Syntax
TCPFCPPORT = n

where n is the port number

Example
TCPFCPPORT = 3002

This is the recommended value. There is no default value. If you don't specify a
TCPFCPPORT, no TCPFCP port is created.

F) Notes

The terminal server has a TCP/IP connection to the server; therefore, this
connection does not require error correction. The connection between the
FirstClass client software and the terminal server, however, passes through a
modem and over telephone lines. Therefore, it requires error correction. A
TCPFCP port uses the FirstClass protocol (FCP) to guarantee the integrity of the
information passing between the FirstClass client software and the TCP/IP
terminal server.

This port accepts connections only from users connecting with a remote session.
Thus the number of simultaneous TCP connections the server can support is
limited by the number of surplus remote sessions on the server.

The TCPFCP port runs the full FCP error-correcting sliding window packet link on
top of a TCP connection. It is intended for use with connections that are not TCP
from end to end (for example, when clients dial into a terminal server connected
to the FirstClass server through TCP/IP). For these types of connections, FCP
does its own error correction.

The TCPFCP connection can also be used to handle users connecting with a
Communications Toolbox TCP/IP tool such as the Outland TCP Tool.

If you are running a terminal server, you must configure it to automatically
connect to the server on the TCPFCP port after it answers an incoming call.

Users who autoregister on port 3002 are defined as remote users.

Sets the port number that accepts connections from users of the FirstClass client
software for Mac and Windows who are connecting with UDP/IP.

Syntax
UDPPORT = n

where n is the port number
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Default
UDPPORT = 810

This is the standard FCP port for UDP, and is the recommended value. If you don't
specify a UDPPORT, 810 is used.

#) Notes

Connections through this port use the flow control and error correction features
of the FirstClass protocol (FCP), making this a more useful choice than TCP/IP for
a slow network connection.

The UDPPORT accepts connections over network and remote sessions.

The number of network sessions the port can support is determined by the
number of network sessions you configure on your server.

The number of remote sessions the port can support is determined by the
number of surplus remote sessions in the server. The server comes with two
remote sessions. You can purchase additional remote sessions.

Users who autoregister on any port other than the TCPGUIPORT, TCPRGUIPORT,
or UDPPORT are defined as regular users.

Top

Enabling UTF-8 on your server

For HTML mail and certain languages to render reliably, you must have UTF-8 enabled on your server. If
you started using FirstClass at version 8.3 or older, your server won't have UTF-8 enabled by default.

&Caution

Enabling UTF-8 will cause compatibility issues with 8.3 or older clients. These clients will still be able to
display and create messages, but some functionality, such as the ability to forward UTF-8 messages,
will be lost. Ensure that the majority of your users are using 9.0 or newer clients before enabling
UTF-8.

To check if UTF-8 is enabled on your server, send the following FirstClass scripting command to batch
admin:

reply

GET SYSPROFILE 1240

If the reply is 1240 6 1, UTF-8 is enabled. If the reply is 1240 6 0, UTF-8 isn't enabled.

To enable UTF-8, send the following command to batch admin:
reply
PUT SYSPROFILE 1240 7 1

You will have to stop and restart your server for this change to take effect.

Top

FirstClass file locations on Windows

After you install the FirstClass server, you'll find the FCServer and FCNS folders in the drive root. They
must remain in the root of the same drive.

The FCServer folder contains the server executable file and all supporting files and folders. It may also
contain files and folders required to run any installed FirstClass services.

The FCNS folder is the server network store. This contains all of the files and folders for all server data.
The integrity of this folder is paramount in maintaining a problem-free system. Never delete, rename,
rearrange, or add any files to/from this folder, or in any other way tamper with its structure or content.

If you installed Internet Services on the same machine as the FCServer, the Internet Services files will also
be in the folder. Otherwise, they will be in a FCServer folder on the Internet Services machine.

The FCServer folder contains the following folders and files:



Seite 14 von 27

fcs64.exe The server application executable.

FCSLang.rez The FirstClass language resource file.

ADMIN.FC A settings file that you can use to log into the server as administrator.

FCP A folder containing FCP files. FCP is the protocol used to communicate between
the FirstClass client or module and the FirstClass server.

FCPUtil.exe The FCPULtil application executable, used to automate certain Windows
applications.

Stats files A folder containing statistics files built daily at midnight.

dbghelp.dll Debug tools from Microsoft.

IndexExtensions A folder containing the indexers for non-FirstClass files (such as .DOC, .PDF, .XLS,
.PPT).

fcs.log and fcs.old The server log file.

Plus these folders and files if you installed Internet Services on this machine:

fcintsrvbe4.exe The Internet Services application executable.
INETSVCS.FC The settings file for Internet Services.
cgi-bin A folder for CGIs, if you've made any available. For information, see Internet

Services online help.
Top

FirstClass file locations on Mac

The FirstClass Server folder

When the FirstClass server was installed, it was done by a user account named FCadmin. After the
installation, you'll find the FirstClass Server and fcns folders in the default installed locations. These folders
must remain in those locations.

The FirstClass server will be installed in /Library/FirstClass Server. The FirstClass Server folder contains the
server executable file, the server log file, and all supporting files and folders. It may also contain files and
folders required to run any installed FirstClass services.

The fcns folder is the server network store. Its location is /Library/FirstClass Server/Volumes/Master/fcns.
This contains all of the files and folders for all server data. The integrity of this folder is paramount in
maintaining a problem-free system. Never delete, rename, rearrange, or add any files to/from this folder,
or in any other way tamper with its structure or content.

If you installed Internet Services on the same machine as the FirstClass server, the Internet Services files
will also be in the FirstClass Server folder. Otherwise, they will be in the corresponding FirstClass Server
folder on the Internet Services machine.

The FirstClass Server folder contains the following folders and files:

o fcsd
The FirstClass core server executable.

e fcsd.rez
The FirstClass server resources.

e fcslang.rez
The FirstClass language resource file.

e FirstClass Server Start.command/FirstClass Server Stop.command
Commands that activate control scripts to start and stop the FirstClass server.

o fcsd.log/fcsd.old files
Log files that are generated every time you start the server or Internet Services. The .log files contain
detailed log entries from the latest run, and the .old files contain the output of the previous run. Because
these files recycle every time you start the server, you lose the information after two restarts. Similar
information is stored permanently, though, in the server logs under /Library/FirstClass
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Server/Volumes/Master/fcns/lodfiles.

Status of FirstClass Services.command
A command file that activates a control script that provides you with the status of the FirstClass server
and Internet Services.

Volumes

A folder in which you can define an explicit list of logical FirstClass volumes accessible to the server.
These need not correspond directly to physical drives, but could also be folders or symbolic links to any
location visible in the Mac file system hierarchy. For this reason, they are referred to as logical volumes.
For more information about FirstClass logical volumes and their uses, see Using FirstClass volumes in the
Administrating FirstClass chapter of this guide.

fcfixvol

A utility you use to properly set the initial permissions on the files and folders in a FirstClass post office
after you copy the post office from one volume to another or restore from a backup. For the purpose of
migration, this includes another utility (fclower.pl) that converts all post office file names to lowercase for
use in the Mac file system.

Internet Services folders and files

The following folders and files are also in the FirstClass Server folder if you installed Internet Services on
this machine:

fcisd
The FirstClass Internet Services executable.

fcisd.rez
The Internet Services resources.

fcp
A folder containing FCP network protocol definition files. FCP is the protocol used to communicate
between the FirstClass client or services modules and the FirstClass server.

config
A folder containing configuration files for Internet Services.

inetsvcs.fc
The settings file for Internet Services.

Internet Services Start.command/Internet Services Stop.command.
Commands that activate control scripts to start and stop Internet Services.

Other files on Mac

It is recommended that you review and understand the ownership, nature, and location of the FirstClass
files and folders (directories) on Mac. While familiarizing yourself with the FirstClass server for Mac, you
may find it convenient to print this information and post it next to the server computer for reference.

fcadmin is the Mac user who executes and manages the FirstClass server and Internet Services. The
fcadmin user belongs to the Mac admin group and owns all of the files.

Several root directories (those that start with “/”) are hidden from the Finder. You must use the Finder’s Go
> Go to menu command, or Command+Shift+G, or the Terminal utility, to see folders such as /usr and
/Volumes.

Locations:

/Library/FirstClass Server/

all executable-related files for both fcsd and fcisd

/Library/FirstClass Server/fcfixvol

a FirstClass fcpo utility to set file permissions and ownership and to convert file names to lowercase.
May be executed at any time.

/Library/FirstClass Server/fcisd.log
/Library/FirstClass Server/fcisd.old

current and prior Internet Services logs since launch, if IS installed on the computer

/Library/FirstClass Server/fcp

the fcp files that inetsvcs.fc uses to establish a connection to the server
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/Library/FirstClass Server/fcsd.log

/Library/FirstClass Server/fcsd.old
current and prior server logs since launch. Equivalent to legacy console to log.

/Library/FirstClass Server/inetsvcs.fc
Internet Services settings file, if IS installed on the computer

/Library/FirstClass Server/Volumes/Master/fcns
the master logical volume

/Library/FirstClass Server/Volumes/.../fcns
a secondary logical volume if present

/Library/FirstClass Server/Volumes/.../ fcns8001
the mirror logical volume if present

Any or all entries under /Library/FirstClass Server/Volumes/ may be links to other directories or
volumes, but the actual fcpo folders, and the folders underneath fcpo, cannot be symbolic links.

) Note

Ensure fcfixvol utility is run at least once on all logical FirstClass volumes before the server is
launched.

/Library/Startupltems/FirstClass Internet Services
installed if IS auto launch selected during installation. This folder can be deleted to stop Internet
Services from being auto-started at system startup time.

/Library/Startupltems/FirstClass Server
installed if server auto launch selected during installation. This folder can be deleted to stop the core
server from being auto started at system startup time.

Library/FirstClass Server/Stats
If desired, you must manually create this folder, as described in Collecting activity statistics in the
Administrating FirstClass chapter of this guide.The above is the recommended path for this folder. It is
not created by default.

/usr/local/fcsctl

/usr/local/fcisctl
the server and Internet Services control scripts used from a Terminal shell, by the desktop icons, and
by the Startupltems scripts. These are not normally visible from the Finder desktop. Choose Go > Go
to Folder (Command+Shift+G) and enter /usr/local to see these files.

55' Note

This folder also includes many Mac system files that should not be modified or deleted.

/Volumes
lists all available Mac desktop-mounted volumes. Do not confuse /Volumes with /Library/FirstClass
Server/Volumes.

Top

FirstClass file locations on Linux

The fcsd folder

When the FirstClass server was installed, it was done by a user account named FCadmin. After the
installation, you'll find the fcsd and fcns folders in the default installed locations. These folders must remain
in those locations.

The FirstClass server will be installed in /opt/fcsd. The fcsd folder contains the server executable file, the
server log file, and all supporting files and folders. It may also contain files and folders required to run any
installed FirstClass services.

The fcns folder is the server network store. Its location is /var/opt/fcsd/volumes/master/fcns. This contains
all of the files and folders for all server data. The integrity of this folder is paramount in maintaining a
problem-free system. Never delete, rename, rearrange, or add any files to/from this folder, or in any other
way tamper with its structure or content.
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If you installed Internet Services on the same machine as the FirstClass server, the Internet Services files
will also be in the fcsd folder. Otherwise, they will be in the corresponding fcsd folder on the Internet
Services machine.

The fcsd folder contains the following folders and files:

o desktop folder
A folder containing the FirstClass objects which have been linked to the Linux desktop. These are the
server and IS start and stop scripts and the status of FirstClass Services script.

o fcsd
The FirstClass core server executable.

o fcsd.rez
The FirstClass server executable's resources.

o fcslang.rez
The FirstClass language resource file.

o fcsd.log/fesd.old files
These server log files are generated every time you start the server. The .log files contain detailed log
entries from the latest run, and the .old files contain the output of the previous run. Because these files
recycle every time you start the server, you lose the information after two restarts. Similar information is
stored permanently in the server logs in /var/opt/fcsd/volumes/master/fcns/logfiles.

ﬁ Note

If you have had previous experience with FirstClass on another platform, you may be used to seeing
the information that is recorded in these log files in the FirstClass server console. This information is
also available from the Remote Console button on the Server Monitor form.

o fcfixvol
A utility used to properly set the initial permissions on the files and folders in a FirstClass network store
after you copy the files from one volume to another or restore from a backup. (fclower.pl) that converts
all network store file names to lowercase for use in the Linux file system.

o fclower.pl
A perl script used when executing fcfixvol -c all all that converts all network store file names to
lowercase for use in the Linux file system.

o fcputil
The FirstClass fcputil executable.

o fcputil.fc
The FirstClass fcputil settings file, required to connect fcputil to the server.

Internet Services folders and files

The following folders and files are also in the /opt/fcsd folder if you installed Internet Services on this
machine:

o fcisd
The FirstClass Internet Services executable,

o fcisd.rez
The Internet Services executable's resources.

o fcisd.log/fcisd.old
These IS log files are generated every time you start Internet Services. The .log files contain detailed log
entries from the latest run, and the .old files contain the output of the previous run. Because these files
recycle every time you start IS, you lose the information after two restarts.

ﬂ Note

If you have had previous experience with FirstClass on another platform, you may be used to seeing
the information that is recorded in these log files in the Internet Services console or the console log
files there.

¢ inetsvcs.fc
The settings file for Internet Services.

Other files on Linux
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It is recommended that you review and understand the ownership, nature, and location of the FirstClass
files and folders (directories) on Linux. While familiarizing yourself with the FirstClass server for Linux, you
may find it convenient to print this information and post it next to the server computer for reference.

"fcadmin" is the Linux user who executes and manages the FirstClass server and Internet Services. The
fcadmin user belongs to the Linux admin group ("adm") and owns all of the files.

Locations:

e /opt/fcsd/
all executable-related files for both fcsd and fcisd

e /opt/fcsd/fcfixvol
a FirstClass network store utility to set file permissions and ownership and to convert file names to
lowercase. May be executed at any time.

e /opt/fcsd/fcisd.log

/opt/fcsd/fcisd.old
current and prior Internet Services logs since launch, if IS installed on the computer

e /opt/fcsd/fcsd.log

/opt/fcsd/fcsd.old
current and prior server logs since launch. Equivalent to legacy Console to file.

e /opt/fcsd/inetsvcs.fc
Internet Services settings file, if IS is installed

e /var/opt/fcsd/volumes
a folder in which you can define an explicit list of logical FirstClass volumes accessible to the server.

e /var/opt/fcsd/volumes/master/fcns
the master logical volume

e /var/opt/fcsd/volumes/.../fcns
a secondary logical volume if present

e /var/opt/fcsd/volumes/.../fcns8001
the mirror logical volume if present

Any or all entries under /var/opt/fcsd/volumes/ may be links to other directories or volumes, but the
actual fcns folders, and the folders underneath fcns, cannot be symbolic links.

) Note

Ensure fcfixvol utility is run at least once on all logical FirstClass volumes before the server is
launched.

e /opt/fcsd/stats
If desired, you must manually create this folder. The above is the recommended path for this folder. It is
not created by default.

e /usr/local/fcsctl

e /usr/local/fcisctl
the server and Internet Services control scripts used from a Terminal shell, and by the desktop icons.
These are not normally visible from the Linux desktop.

) Note

This folder also includes many Linux system files that should not be modified or deleted.

e /mnt
usually lists all mount points for Linux volumes. Do not confuse /mnt with /var/opt/fcsd/volumes.

Top

Working with firewalls

About firewalls

A firewall is a network security tool used to monitor and guard traffic passing through a network. It usually
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resides on its own computer. A true firewall does not scan your system for viruses and trojan horses, nor
scan incoming packets for a virus. However, some firewall products are bundled with virus software
providing varying levels of virus protection.

The basic firewall architecture is always the same, with minor variations depending upon the type of
firewall you use. Every packet sent from the Internet is first examined on the firewall server. As well,
packets sent from your network are also examined on the firewall server. Think of this as the main gate for
all traffic, also called the "choke point". It is the computer between the Internet and your network that
maintains the security of your system.

There are three main types of firewalls, all of which combine hardware and software to achieve maximum
protection. Each type of firewall uses a different technique to protect your network.

A network-level (or packet filter) firewall analyzes network traffic at the transport protocol layer and
compares it to a predefined set of rules that indicates which protocols are allowed.

A circuit-level firewall takes this one step further and validates that a packet is either a connection request
or a data packet belonging to a connection between two peer transport layers. This is done by examining
each connection setup, and then comparing the connection to a table of valid connection that includes
complete session state and sequencing information.

An application-level firewall provides more detail than the other types. It evaluates individual network
packets for data at the application layer before allowing a connection. It examines the data in all network
packets and maintains complete connection state and sequencing information.

Network-level firewalls are the fastest and least secure. Application-level firewalls are the slowest and most
secure. Circuit-level firewalls fall between these two in speed and security.

Using FirstClass with firewalls

FirstClass Internet Services has a built-in security feature that performs filtering, thereby acting as a
network-level firewall for Internet protocols. For more information, see the Internet Services help.

Proxy servers are a good choice for environments that require high security. Because the auditing and
filtering is performed by an actual application, the proxy is slower than a network-level firewall. Therefore,
place the application-level firewall on the fastest computer host in your network (after the FirstClass server
and FirstClass Internet Services computers are selected).

The FirstClass client supports only the SOCKS4 proxy interface directly. Client use through a firewall must
be in one of two configurations: NAT (Network Address Translation), or SOCKS4.

Using NAT

To configure the FirstClass client to use NAT, simply set the client machine's network gateway to the NAT
router machine. This is an operating system setting; therefore, no FirstClass configuration is required.

) Note

NAT is used mostly for outbound client machines on a private network that will connect to the Internet.
From a client perspective, NAT is the preferred approach. However, it would not be appropriate for a
server on a private network.

Using SOCKS4

To configure FirstClass under SOCKS4:

1 Click Setup on the Login form.
Specify the server machine as usual.
Choose TCP/IP.

Click Configure.

u A W N

Choose the following on the Settings tab:
e TCP Default 510 at Port humber.

e Default (1080) at Proxy port.

e 0.0.0.0 at Proxy IP address.

Anything other than 0.0.0.0 in the proxy server field tells the client/outbound connections to be
diverted to that address, informing the proxy server of the desired address using the SOCKS4
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interface.
e Default at Buffer size.

The proxy server then relays the connection request to the desired IP address on the client's behalf. In
addition to knowing the proxy server's IP address, the client software also has to know what port the proxy
server is listening on, much like the client must specify port 510 to talk to our servers.

In order to configure the FirstClass server to work behind a firewall, it is necessary to open the appropriate
connections on the firewall.

Any ports specified in the Netinfo file, or by the defaults for the Netinfo port configuration, must be
supported by the SOCKS4 proxy server. This typically means port 510 must be accepted for relaying by the
proxy server (referred to as "open"). To use additional ports (such as both TCPGUIPORT and
TCPRGUIPORT) listed in the Netinfo file, the proxy server would have to be configured to open these ports.

Port 23 is the Internet "telnet" program's port, which is used for the CLUI interface. To use the CLUI
through a proxy server, you need a telnet program or terminal emulation program (for example, Procomm
Plus or HyperTerminal) that supports proxy connections to a TCP telnet host. If you use CLUI, the
FirstClass client software and FCP protocol are not involved. Communication occurs between the terminal
program and the proxy server. For example, the terminal program and proxy server may support SOCKSS5,
and they could use that to connect over the CLUI.

If FirstClass Internet Services is on the outside of a firewall, the proxy server will need to include the
Internet ports it supports in the list of ports opened for external access. This is usually set already, as it
was for telnet, because most proxy servers have default configurations that open port 25 (SMTP), port 80
(HTTP), port 110 (POP3), port 119 (NNTP) and other common Internet ports.

Because FirstClass Internet Services and the server can run on two different machines, it is possible to
place Internet Services on the public/Internet side of the proxy server, leaving the core server on the
private side.

Some sites choose to isolate their server from the Internet, requiring a SOCKS4 proxy for FirstClass client
connections, including possibly a SOCKS4 connection to the server from Internet Services over port 510 or
another port. This scenario does not add security; the server is secure in either case.

Port requirements

These are the port numbers that must be open for each connection type when setting up your firewall:

Port Protocol Comments

21 FTP Ensure this port is accepted for relaying (referred to as "open").

23 CLUI/Telnet Ensure this port is open. This is the Internet "telnet" program’s port,
which is used for the CLUI interface.

25 SMTP Ensure this port is open on the firewall for two-way communication. It
is usually the default configuration on the proxy server.

53 DNS Ensure this port is open. Although we do not support DNS, we need to
connect to DNS servers on this port.

79 Finger

80 HTTP Ensure this port is open on the firewall for two-way communication. It
is usually the default configuration on the proxy server.

110 POP3 Ensure this port is open on the firewall for two-way communication. It
is usually the default configuration on the proxy server.

119 NNTP Ensure this port is open on the firewall for two-way communication. It
is usually the default configuration on the proxy server.

143 IMAP

389 LDAP

443 HTTPS

510 TCP FCP Ensure this port is open on the proxy server on firewall for two-way

communication. To use additional ports (such as both TCPGUIPORT and
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TCPRGUIPORT) listed in the NETINFO, the proxy server would have to
be configured to open these ports.

810 UDP FCP This port is used for IP Network Notifier.
3000 FCP FirstClass client Legacy TCP port (not required with newer client
versions)
Top

Running FirstClass as a Windows service

You may choose to configure your FirstClass server and/or Internet Services to run as a Windows service.
If you choose this option, your FirstClass server and/or Internet Services will start up and shut down
automatically when you start up or shut down your Windows machine. If you simply log off of the Windows
machine, your FirstClass server and/or Internet Services will not shut down, but will continue to perform
normally. This can increase the security of your FirstClass system.

Voice Services does not run as a Windows service. If you shut down the Windows machine without
correctly shutting down Voice Services, the module will not shut down correctly, nor will it start up
automatically when the Windows machine is restarted. If you log out of your Windows machine where
Voice Services is currently running, it will not continue to run. Therefore, if you opt to run the FirstClass
server and/or Internet Services as a Windows service, you should install Voice Services on a separate
machine.

When you install your FirstClass server and/or Internet Services on a Windows machine, a FirstClass
Services control panel applet will automatically be installed on this machine. The FirstClass Services
Options form is opened through the Control Panel.

The FirstClass Server and Internet Services tabs are almost identical, except for the module they affect.

Only run as an Windows service Prevents users from starting the FirstClass server and/or Internet
Services by running the executable directly. It may help avoid accidently
shutting down the server or Internet Services incorrectly when shutting
down Windows. If they are run strictly as Windows services, they will
always shut down correctly when Windows is shut down.

Only use event log when Stops logging of events to the Event Log when the FirstClass server
running as a service and/or Internet Services have been started manually.
Install Service Runs as a Windows service. FirstClass server and/or Internet Services will

appear in the Services list (Start > Control Panel > Services) where they
can be started and stopped. You can continue to run your FirstClass
server or Internet Services as a normal application by running the
FCS.EXE or FCINTSRV.EXE executable directly unless you checked Only
run as a Windows service.

) Note

You must start FirstClass Internet Services once to set up the
necessary registry keys for Interent Services to operate as a service.

Uninstall Service Removes from the list of available Windows services.

Make IS dependent on FCS Makes Internet Services startup dependent on FirstClass server startup.
(on Internet Services tab only)

Windows Event Log Level Select the logging level you prefer.

FirstClass logfile messages are mapped to Windows events, complete
with severity categorizations, standard FirstClass error numbers and
descriptions. The control panel allows you to control the severity
threshold at which FirstClass messages are added as Windows events.
The severity categories are as follows:

Examples of FirstClass error messages in each category:

Information - errors that are normally not logged, such as:
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1035 Invalid password

1003 No such user

1040 Can’t forward

1036 Can’t reply

1049 Daily time limit exceeded

1053 Logins are disabled

1080 Name already in use

1084 Object in use

1093 User has reached/exceeded disk space limit
1096 Must read

Warning - more significant errors, such as:
1044 Server not found

1027 Communication link has failed

1092 User session memory limit reached
Error - all other errors of consequence.

For all information about FirstClass error messages, see Server
maintenance.

To view the event log, use the standard Windows Event Viewer by
selecting Programs > Administrative Tools > Event Viewer from the
Taskbar. Select Log > Application. FirstClass server events will be
displayed with a value of "FCS" under the "Source" column. FirstClass
server error codes (for example, 1027, 1035) will be displayed under the
"Event" column as appropriate.

Controlling FirstClass server using Windows Utilities

When installed as a service, you can use the Windows NET command to start and stop the server:
NET START FCS

NET STOP FCS

The PAUSE and CONTINUE commands are supported for network store mirroring.

NET PAUSE FCS

NET CONTINUE FCS

NET CONT FCS

You can also use FCPUTIL for the same purpose.

Advanced topics

When running FirstClass server and/or Internet Services as a Windows service configured to start
automatically, your server and/or Internet Services will start automatically when the Windows machine is
started. The machine does not have to be logged in. If the machine is not logged in, but is started, there
will be no desktop, no current user context, and no windows or other user interface elements. Still, your
FirstClass server and/or Internet Services will be running normally (automatically recognizing user logins
and logouts, and acting appropriately). If not running as a Windows service, a user logging off of the
Windows machine where the FirstClass server is installed will trigger a fast shutdown of the FirstClass
server and/or Internet Services. When running as a service, it will not have any noticeable effect, except,
of course, that the server's console window will not be visible after logout. It is still there, however, and will
be displayed if the user logs back in.

It is important to recognize that all of this user interface related functionality is dependent on FirstClass
being configured as an interactive service. The FirstClass control panel automatically configures FirstClass
as an interactive service when you click Install. When in doubt, it is safe to click Uninstall, followed by
Install to reset the server's Windows service configuration to defaults. It can also be inspected or
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overridden from the standard Windows Services list using the following procedure:
Open the Control Panel.

Double-click Services.

Select "FirstClass server".

Click Startup.

u H W N =

To enable interactive support, select "Allow service to interact with desktop".

On this same form, you can configure the FirstClass service to run under the context of a specific Windows
user account. This is not recommended. Instead, select "System accoun"t and then select "Allow service to
interact with desktop", as described above.

Making network drives available to Windows services

Windows services running under the "Local System" account are defined by the system to have no network
access. (See service properties screenshot below.)

The problem here is not with user names, passwords, or startup timing; the problem is that services
running under the "Local System" account are not able to see network drives, by definition. That is part of
the Windows design.

Secure but read-write access to network drives must occur through a different, specific user context.
Furthermore, what you map as a local drive from your Windows session is independent of what the service
sees, as it is running in a completely different user environment. (Think: multiple concurrent logins here,
and the service is running as "Local System" before you log in.)

To solve these problems, the service needs to directly support mapping network drives using credentials
supplied by you. This is accomplished using the volumes.cfg configuration file located in the FCServer
folder.

This configuration file is a simple text file formatted as keyword=value pairs (like a Windows INI file, and
similar to the inetsvcs.cf file or the server's NETINFO file).

To create auto-mounting volumes for the FirstClass server, first you must create a [Config] section.
Currently, there are two keywords that can be used there.

e The first [Config] keyword is Mounts, which is the number of volumes to mount. For example,
Mounts=2.

For each of those drive mounts, create a [MountN] section, where 'N' is an index, from 1 to Mounts. In
the example above, it would be [Mount1] and [Mount2]. In each of those sections, provide the remote
UNC path of the volume to mount, the local mount point (drive letter), and the user ID and password
for that remote server.

e The second [Config] keyword is Primary, which allows you to tell the FirstClass server that the
primary FCNS volume is not the same volume where the executables folder is found. This allows you
to start the FirstClass server on a local volume, for example from a Windows service, then have it
mount a volume that it will use as the primary FCNS volume.

The [volumes] section is optional, and not needed for most installations. It allows you to override
(specify) the FirstClass name for the mounted volume. This is what is displayed in the Volumes list on the
administrator's Desktop. The primary volume must be called "Master" (OS X) or "master" (Linux), so that
example is also used here in this Windows example file.

The format is VolumeName=MountAsName.

The label before the '="is the volume name to use; the drive path after the '=' corresponds to the MountAs
name from one of the Mount sections that follow (or a local drive path). The [volumes] section is not
needed unless a Primary= option is specified, but in that case, the specified volume name must be
available after mounting.

Example volumes.cfg file

[Config]
Mounts=2
Primary=Master

[Volumes]
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Master=F:\

[Mountl]
Mount=\\server\firstclass
MountAs=F:

User=server\me
Password=secret

[Mount?2]
Mount=\\server\mirror
MountAs=M:
User=server\me
Password=secret

This example file uses colors to attempt to better illustrate the relationship between the entries. For
example:

e The Mounts=2 directive shows that the server expects to find two Mount sections, Mountl and
Mount2.

e The volume name specified in the Primary= line must exist in the [Volumes] section, and must match
the name specified (Master).

¢ On Windows, the path of the volume (F:\) follows the Master= line and corresponds to a MountAs
name in one of the mounts.

This would mount two network volumes (firstclass and mirror), from the server file server, as drives F: and
M:, respectively.

Furthermore, the Primary directive tells the server to look for the primary FCNS folder under
\\server\firstclass (which is mounted as F:). This allows the core server to start from a different disk
volume than the volume containing the primary FCNS. This is most useful for Windows services, allowing
the FirstClass server to be installed on the Windows system volume, but then mount a network volume for
use as the primary FCNS volume.

F) Notes

Windows has a limitation that all drives mapped from any given server to a given machine must use
the same user credentials.

You must specify the authentication domain (typically the file server name) in the User field with a
backslash before the actual user ID is specified (see the example above).

Top

Working with multiple volumes

Large FirstClass systems may require a network store that spans multiple volumes. Additional volumes can
be any hard disks installed on your computer, and any network drives to which the computer has read and
write access. You can't use diskettes as additional volumes. When using Mac, you might have multiple
volumes mounted on your desktop. Typically, each volume corresponds to a physical hard disk. You can
also use disk formatting software to create multiple volumes on a single physical disk.

You might choose to install your network store on multiple volumes in one of the following situations:
¢ You have a large FirstClass system.

e If you have only a small percentage of your disk available for use, or you run out of disk space, your
FirstClass system may be too large for its current hardware configuration.

e You want to control the amount of space available to specific users or conferences.
For example, a FirstClass server might have three volumes:
¢ internal users located on the primary volume
e external users, such as customers and suppliers, on the first secondary volume
¢ replicated conferences on the second secondary volume.

If either secondary volume becomes full, internal users will not be affected.
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ﬂ Note

A multi-volume network store is more complicated to administer. There are no performance, reliability,
or feature enhancements if using the multi-volume feature when it is not needed. Use a single volume
if possible.

Remember two things when assigning users and conferences to volumes:

e When a user sends a message, FirstClass keeps one copy of the message. This copy stays on the
sender’s volume until the sender and all recipients have deleted it, or until it expires.

¢ If you are using conference replication, any conference items received from other servers are stored on
the volume containing the conference.

Assign users who habitually send large attachments or post large messages to conferences to volumes with
ample disk space. Similarly, place large, replicated conferences on volumes with sufficient free space.

Understanding the status of volumes

Before you can assign users or conferences to a volume, the volume must have a status of Full use. When
you install your server, only one volume has that status — the volume on which you installed the FirstClass
server. This volume is the master volume.

Audit is performed only on Full use volumes. The audit task does not check other volumes, even if they
contain network stores. This means, a volume that had a status of Full use and was later reduced to
Limited use or Browse only will not be checked during audit.

You can make full use of any hard disks installed on your computer and any network drives to which the
computer has read and write access. You cannot make Full use of diskettes.

Full use volumes
You can add users and conferences to any Full use volume.

If you subsequently change the status of a Full use volume to Limited use or Browse only, the folder
containing the FirstClass network store is not deleted. The volume will not appear on the list of available
volumes for your system and the volume will behave as described below.

Limited use volumes

When a volume’s status is Limited use, you cannot create new conferences or users on the volume, but
you can create aliases. The volume will not be checked during trash collection, and conference information
on the volume will not be accessible. Once all items on the volume expire, the volume will disappear.

Browse only volumes

When a volume’s status is Browse only, you cannot create any new users, conferences, or aliases. The
volume will not be checked during trash collection, and conference information on the volume will not be
accessible. Once all items on the volume expire, the volume will disappear.

Changing the status of additional volumes to full use
To change the status of additional volumes to full use (thus making them secondary volumes):
1 Double-click Volumes on the administrator's Desktop.

Names of browse-only volumes appear in italics in the volume list.

) Note

If you mount a new volume on your computer (for example, if you connect to a network drive),
close and reopen the Volumes folder to refresh the list.

Select the volume you want to make full use.
Choose File > Properties (Windows) or Get Info (Mac).

Select "Full use".

Using FirstClass volumes on Mac and Linux

The Mac and Linux FirstClass servers support logical FirstClass volumes. The Mac operating system mounts
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volumes under a /Volumes path. The Linux system mounts volumes into arbitrary locations in the root file
system directory tree, typically under the /mnt directory.

The FirstClass server could use this list directly, however that wouldn't be universally accurate, and would
remove the flexibility of allowing you to control what volumes are visible to FirstClass administrators who
have access to the Volumes list. This is important not only for security reasons, but also for performance
reasons. It is important for you to be able to insert CDs and DVDs or mount network volumes without
having these appear automatically to the FirstClass server.

The FirstClass Volumes list

The FirstClass server therefore allows you to define an explicit list of volumes accessible to the server.
These need not correspond directly to physical drives, but could also be folders or symbolic links to any
location visible in the file system hierarchy. For this reason, they are referred to as logical volumes.

) Note

Although logical FirstClass volumes can be symbolic links to any location, the fcns (FirstClass network
store) folder in each volume and the files contained within that folder must be normal folders and files
rather than symbolic links.

Logical FirstClass volumes are stored within the FirstClass Server folder under /Library, in a subfolder
called Volumes (Mac) or /var/opt/fcsd/volumes/ (Linux). Any folder (or symbolic link to a folder) in this
Volumes folder is considered to be a logical FirstClass volume, and will show up in the FirstClass Volumes
list on the administrator’s Desktop. An additional entry corresponding to the root of the file system will
automatically appear in the FirstClass Volumes list.

Uses of logical volumes

In addition to being able to refer to multiple specific physical drives from FirstClass, logical FirstClass
volumes can be used to partition users and/or conferences into logical groups, such as a separate logical
volume for Internet news groups, that can later be split into separate physical devices. To do this physical
split at a later date, you would move the files to the desired location and replace the FirstClass folder with
a link to the other location in the file system.

Logical volumes also allow multiple formerly migrated server volumes to be merged onto one or more
physical drives. To do this, put the network stores in separate folders under the Volumes folder.

And finally, they also leverage one of the greatest strengths of UNIX-based systems, the logical union of
different objects under the single umbrella known as the root file system. Defining a FirstClass volume as
either a folder in the file system or a link to an arbitrary location in the root file system allows for
maximum flexibility.
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Using external folders

You can use external folders to give users access to the folders on any storage device available to the
server machine. They are useful if you have large numbers of files (for example, on a CD-ROM) that you
want to make available to your users. It's easier to drag files into a folder on your hard drive than to
upload them all to a conference.

When users open an external folder, they actually see the contents of the folder outside the FirstClass
system. Users can do the following with external folders:

o view folder contents
o view text files, preview certain types of picture or sound files, and download files
e search the filenames and content of text documents.

External folders work equally well for remote and network sessions.

External folders are read only. You cannot upload files to an external folder from within FirstClass.

Approving volumes for external folders

Before you create external folders, you must approve the volumes containing the external information.

) Note
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During FirstClass installation, an external folder named Hard Disk is placed on the administrator's
Desktop. This folder links to the master volume. We do not recommend that you give all your users
access to this external folder because the master volume can contain private or non-relevant
information.

To make a volume available for external folders:
1 Double-click Volumes on the administrator's Desktop.

The names of unapproved volumes appear in italics. If you mount a new volume on your computer (for
example, if you connect to a network drive), you must close and reopen this folder to refresh the list.

2 Select the volume you want to approve.
3 Choose File > Properties (Windows) or Get Info (Mac).
4 Select "Limited use".

FirstClass marks this volume as available for external folders.

Creating external folders

To create an external folder:

Double-click Volumes on the administrator's Desktop.

Double-click the volume containing the folder to which you want to link.

Navigate through the volume and select the folder to which you want to link.

Choose Collaborate > Add to Desktop to create a link to the folder on the administrator's Desktop.
Close the Volumes form.

Open the Model Desktop of the user group or individual user who needs access to this folder.
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Drag the link to the Model Desktop and update the Desktop.

Linking external folders to CD-ROMs
If you are considering linking an external folder to a CD-ROM, be aware of the following:

e The link is specific to the disk in the CD-ROM drive at the time you make the link. If you put in another
disk, users won't be able to use the link.

e CD-ROM access is slower than access to normal hard disk drives.
Here are some tips to minimize performance problems:

e Avoid multi-CD changers. They generally take several seconds to change disks. If you have two users
accessing different disks, the changer shuffles continuously, consuming most of the server's resources,
and the server stops running during the time between loading and unloading the CD-ROM.

e Buy the fastest CD-ROM you can afford.

o If you have a very large system, consider purchasing a large hard disk, copying the CD-ROM to the hard
disk, then linking to the hard disk. Although this approach is expensive, it gives you the best possible
performance. It also allows you to omit any resources on the CD-ROM that are of no interest.

Linking external folders to file servers

If you create external folders that link to a file server, be sure the file server is available when your
FirstClass Server is running.

If the file server shuts down, a dialog may appear to notify you of a problem. If this happens, click OK to
continue.
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